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Preface

Preface

This Installation Guide introduces SafeSync and guides you through planning the
installation and installing SafeSync.

Topics in this chapter include:

What's New in This 1V ersion on page iv
SafeSync Documentation on page v
Audience on page v

Document Conventions on page vi

Terminology on page vii
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What's New in This Version

The following new features and enhancements are available in version 2.1:

TaBLE 1. New Features and Enhancements

FEATURE DESCRIPTION

Active Directory integration «  Enhanced Active Directory integration

- Select and assign Active Directory
users and groups permission to use
the SafeSync service from the
SafeSync web console

Shared Protection Extension add-in - File encryption
- Secure file sharing

- Encrypt files under a folder
automatically

Outlook Extension add-in Enhanced with the Shared Protection
Extension features

Dashboard widget System Status Alert widget

Policy management Control how end users share and upload
files

Plan management Assign plans to users by plan order or

select a specific plan for them

Logs +  Log query
+  Log maintenance

- Syslog server settings

Administration - System updates

+  License management for SafeSync
add-ins

End user mobile apps User interface enhancements
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SafeSync Documentation

SafeSync documentation includes the following:

TaBLE 2. SafeSync Documentation

DOCUMENTATION DESCRIPTION

Installation Guide | A PDF document that discusses requirements and procedures for
installing SafeSync.

Administrator’s A PDF document that discusses getting started information and

Guide SafeSync usage and management.

Help Hosted HTML files that provide "how to's", usage advice, and field-
specific information. The Help is accessible from the SafeSync web
console.

Readme file Contains a list of known issues and basic installation steps. It may

also contain late-breaking product information not found in the Help
or printed documentation

Knowledge Base | An online database of problem-solving and troubleshooting
information. It provides the latest information about known product
issues. To access the Knowledge Base, go to the following website:

http://esupport.trendmicro.com

Download the latest version of the PDF documents and readme at:

http://docs.trendmicro.com

Audience

SafeSync documentation is intended for administrators responsible for SafeSync
management, including SafeSync installation and management. These administrators are
expected to have advanced networking and server management knowledge.



http://esupport.trendmicro.com
http://docs.trendmicro.com
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Document Conventions

The documentation uses the following conventions.

TasLE 3. Document Conventions

CONVENTION DESCRIPTION

UPPER CASE Acronyms, abbreviations, and names of certain
commands and keys on the keyboard

Bold Menus and menu commands, command buttons, tabs,
and options

Italics References to other documents

Monospace Sample command lines, program code, web URLs, file

names, and program output

Navigation > Path The navigation path to reach a particular screen

For example, File > Save means, click File and then click
Save on the interface

Configuration notes

Note

Q Tip Recommendations or suggestions
Important Informatlon regardlng're.qu[red or default configuration
settings and product limitations

Critical actions and configuration options

9 WARNING!
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Terminology

The following table provides the official terminology used throughout the SafeSync
documentation:

TaBLE 4. SafeSync Terminology

TERMINOLOGY DESCRIPTION

Administrator (or SafeSync | The person managing the SafeSync server
administrator)

Console The user interface for configuring and managing
SafeSync.

The console for the SafeSync server program is called
"web console".

End-user Users that share content using SafeSync.
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Preparing for Installation

This chapter introduces SafeSync, deployment recommendations, and system
requirements.

This chapter includes the following topics:
s About SafeSync on page 1-2
« Deploying SafeSync on page 1-4

» System Requirements on page 1-4
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About SafeSync

Trend Micro SafeSync is a turnkey solution for the Enterprise to the private cloud.
SafeSync provides a seamless data accessing experience to users in a more secure,
flexible and convenient way.

+  Integrated with most external storage types (SAN or NAS).
+  Support Active Directory integration.

+  Secure your data in the private cloud at any time. SafeSync supports file version
control and redundant backups of your data.

. Access your data using various devices (PC, Mac, Android, iOS devices)

+  Enhance teamwork using a shared collaborative data space.

Why Use SafeSync
SafeSync provides the following:
BENEFIT DEscRIPTION
Access files from Anytime, anywhere file accessing, editing, and organizing
anywhere from any device: PCs, Macs, and Android, and iOS mobile
devices.

Sync files continuously | Data storage and synchronization with additional file copies
and automatically held on your on-premise servers that can be easily restored or
accessed, in case of a hardware loss, theft, or failure.

Continuous automatic file synchronization with 2 ways to
synchronize files. End-users can drag and drop files easily
into the folder they wish to sync.

Folder pairing enables automatic syncing of an entire folder
without the need to drag and drop into the SafeSync folder.
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BENEFIT

DESCRIPTION

Share files easily and
securely

Fast and secure file and folder sharing with the shareable link.

Set links with passwords that expire for additional security.

“Team Folders” for effective group collaboration that can be
created on the fly by staff and administrators.

Easily create and
control user accounts

SafeSync supports centralized administration for creating and
controlling users.

Recover previous
versions of files

Recovery of deleted files or previous file versions allows you
to turn back time.

Control your own data

You operate the data center, so no third party has access to
your data.

Protect files with
encryption

Protect files with the same Advanced Encryption Standard
(AES) 256-bit encryption used by government and the military.

Securely share email
attachments sent from
Microsoft Outlook

When the SafeSync Outlook Extension is enabled, users
can either upload their attachments to SafeSync and send a
shareable link in the email, or use the auto-encryption option
to automatically encrypt file attachments.

When the auto-encryption option is enabled, all attachments
are automatically encrypted and the only people who can
open the attachments are the SafeSync users who are the
original recipients of the email.

The SafeSync Outlook Extension helps to prevent
unintentional data leakage through misdirected or forwarded
emails, or device loss.

Automatically encrypt
files using an auto-
encryption folder

When the Shared Protection Extension is enabled, users
can create an auto-encryption folder. All files added to this
folder are encrypted automatically.

When a user creates an auto-encryption folder, they are
prompted to identify who can acces the folder. An auto-
encryption folder is essentially an encrypted team folder.

Use the auto-encryption folder to securely share sensitive
files, such as those used by Human Resources or Finance.
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BENEFIT

DESCRIPTION

Convenient remote
administration

You have the ability to control user accounts and share or
revoke access to your shared files at any time.

Built-in security

SafeSync has a built-in firewall that stops network traffic that
is not required for sharing files.

Load balancing

Installing two SafeSync appliances ensures constant
availability of online backup and file restoration, even in the
event of equipment failure.

Redundant server and
Internet connections

Two copies of data are stored on two separate servers plus
two separate service providers connecting the data center
ensuring availability of data.

Deploying SafeSync

SafeSync can be installed in a single appliance deployment or as a set of paired
appliances. When deploying as a set of paired appliances, the first appliance (primary
server) is the parent appliance. The other appliance (secondary server) is the failover

appliance.

System Requirements

The following table provides the system requirements for using SafeSync.

TaBLE 1-1. System Requirements

HARDWARE/SOFTWARE

DESCRIPTION

Network switch

1GB

CPU

64-bit x86 (dual-core recommended)

Memory

8GB (32GB recommended)

Network card

Two 1GB NIC
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HARDWARE/SOFTWARE

DESCRIPTION

System disk space

60GB (for SafeSync installation)

Storage disk space

The disk storage depends on the needs of the users in
the network.

Tip

Trend Micro recommends allocating 8 to 10GB to
each user. If you want to replicate all of users’
files, the allocated space is doubled (16-20GB).
For example, if you intent to have 100 users, the
recommended storage space is 2TB.
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Installing SafeSync on Bare Metal
Servers

Install one SafeSync and shared data is backed up on storage devices the administrator
specifies. However, if the appliance encounters any issues end-users will not be able to
access their shared data.

v
Trend Micro recommends installing two SafeSync appliances for high availability of
SafeSync for end-users.

This chapter has the following topics:
« Installing a SafeSync Appliance on page 2-2

« Installing SafeSync Appliances for High Availability on page 2-3
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Installing a SafeSync Appliance

Any existing data or partitions are removed during the installation process. Back up any
existing data on the system (if any) before installing SafeSync.

Procedure

1.  On a Bare Metal server, insert the installation DVD into the DVD drive of the
desired server.

2. Power on the Bare Metal server.
A prompt appears with information about installing SafeSync.
3. Click OK.
The License Agreement screen appears.
4. Sclect Agree and Install to agree to the license agreement.
The Select Installation Type screen appears.

5. Select Primary server to install a single server or to install the first server in a high
availability deployment.

6. Click OK
The Confirm Web Console Settings screen displays.

7.  Sclect one of the following to determine the connection settings for the end-user
and management web consoles:

+  Select yes to use the default connection settings.
+  Select no to modify the connection settings.

Once installation completes the Log On screen for the command line interface
appears.

8.  Using a web browser, log on to the web management console (<SafeSync domain
name>: 3443) with the following user name and password:

. user name: administrator
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+  password: safesync

Installing SafeSync Appliances for High
Availability

Any existing data or partitions are removed during the installation process. Back up any
existing data on the server before installing SafeSync.

Procedure

1. Install the first SafeSync appliance. See Installing a SafeSync Appliance on page 2-2 for
instructions.

2. On asecond Bare Metal server, insert the installation DVD into the DVD drive of
the desired server.

3. Power on the Bare Metal server.
A prompt appears with information about installing SafeSync.
4. Click OK.
The License Agreement screen appears.
5.  Seclect Agree and Install to agree to the license agreement.
The Select Installation Type screen appears.

6.  Sclect Secondary server to install the second server in a high availability
deployment.

7. Click OK.
The Confirm Web Console Settings screen displays.

8.  Select one of the following to determine the connection settings for the end-user
and management web consoles:

«  Sclect yes to use the default connection settings.
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+  Select no to modify the connection settings.

Once installation completes the Log On screen for the command line interface
appears.

9. Using a web browser, log on to the web management console (<SafeSync domain
name>: 3443) with the following user name and password:

. user name: administrator

. password: safesync
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Installing on VMware ESXi

When installing SafeSyncon a VMware ESXi, the virtual machine requires the following:

SYSTEM

Minimum REQUIREMENT

Virtual machine

VMware ESXi™ 4.x, 5.x

CPU 64-bit single core
RAM 8GB

Hard disk 60GB

Network cards Two 1GB NIC

Procedure

1. Launch VMware ESXi.

2.  Select File > New > Virtual Machine from the menu.
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The Create New Virtual Machine screen appears.

@ Create New Virtual Machine

ESRECRE X

Configuration
Select the configuration for the virtual machine

Virtual Machine Version: 8

ration .
gur
Mame and Location = .
0
Storage Typical
Guest Operating System Create a new virtual machine with the most common devices and configuration options.
Network
Create a Disk " Custom
ReaHly W coplet? Create a virtual machine with additional devices or spedific configuration options.

__tep |

< Back | Mext > I Cancel

Ficure 3-1. Select Configuration

3. Seclect Typical.

4. Click Next.

=
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The Name and Location screen appears.

(&) Create New Virtual Machine

Name and Location

Virtual Machine Version: 8
Specify @ name and location for this virtual machine

Confiquration

Name and Location
Storage

Guest Operating System
Network

Create a Disk

Ready to Complete

MName:

Safesync for Enterprise

Virtual machine (VM) names may contain up to 80 characters and they must be unique within each

vCenter Server WM folder.

VM folders are not viewable when connected directly to a host. To view VM folders and specify a location

faor this VM, connect to the vCenter Server.

e |

< Back | Mext = I

)

Ficure 3-2. Name New Virtual Machine

5. Type a name for the virtual machine.

6. Click Next.
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The Guest Operating System screen appears.

(&) Create New Virtual Machine : @ﬂn

Guest Operating System irtual Machine Version: 8
Specify the guest operating system to use with this virtual machine

Configuration

Name and Location GAESLUDETding Sets
Storage T Windows

Guest Operating System =

Network £ tinux

Create a Disk & Other

Ready to Complete

Identifying the guest operating system here allows the wizard to provide the appropriate defaults for
the operating system installation.

Help | < Back | Mext = Cancel

Ficure 3-3. Guest Operating System
7.  Select Other and choose Other (64-bit) from the drop-down.

8. Click Next.
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The Network screen appears.

(&) Create New Virtusl Machine == X

Hetwork
Which network connections will be used by the virtual machine?

Virtual Machine Version: 8

Configuration

— Create Network Connections

Mame and Location
Storage How many MICs do you want to connect? m
Guest Operating System
Network (,:;:r:;‘:(cg:t
Create a Disk Adapter
Ready to Complete

! * E1000 - ¥

MNIC 2: [private Netwark | [E1000 B

@ If supparted by this virtual machine version, more than 4 NICs can be added after the
virtual machine is created, via its Edit Settings dialog.

Adapter choice can affect both networking performance and migration compatibility. Consult
the VMware KnowledgeBasefor moreinformation on choosing among the network adapters
supportedfor various guestoperating systemsand hosts.

LI <Back | Next> | Concel

A |
Ficure 3-4. Create Network Connections
9. Select 2 NICs and specify the following settings:
TaBLE 3-1. Network Settings for SafeSync
NamE NETWORK ADAPTOR CoNNEcT AT Power ON

NIC 1 VM Network E1000 Enabled

NIC 2 Private Network E1000 Enabled
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10. Click Next.

The Create a Disk screen appears.

—
(&) Create New Virtual Machine o

Create a Disk Virtual Machine Version: 8
Spedify the virtual disk size and provisioning palicy

Confiquration Datastore: Idaiz:skirel
Mame and Location
Storage

Available space (G8): [ e
Guest Operating System =

Metwark - =

e Virtual disk size: I 3

Create a Disk i il
Ready i Compiete % Thidk Provision Lazy Zeroed

" Thick Provision Eager Zeroed
£ Thin Provision

Help | < Back | Next > Cancel
- )
Ficure 3-5. Create Disk Settings

11.  Select at least 60GB of virtual disk space for SafeSync.
12. Sclect Thick Provision Lazy Zeroed.

13. Click Next.
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The Ready to Complete screen appears.

@ Create Mew Virtual Machine
Ready to Complete Virtual Machine Version: 3
Click Finish to start a task that will create the new virtual machine
Configuration ) Settings for the new virtual machine:
:7;"1& B Lacalics Name: New Virtual Machine
rage :
ook O aivie Sy Host/Cluster: localhost.client.tw.trendnetorg
Netwark Datastore: datastorel
Create a Disk Guest05: Other (§4-bit)
Ready to Complete NICs: 2
NIC 1 Network: VM Netwaork
NIC 1 Type: E1000
NIC 2 Network: Private Network
NIC 2 Type: E1000
Disk provisioning: Thick Provision Lazy Zeroed
Virtual DiskSize: 60 GB
[ &t e virbual machine setings before completion |
R ———— el
/4 Creation of the virtual machine (VM) does not indude automatic installation of the guest operating
system. Install a guest OS5 on the YM after creating the VM.
Help | < Back | Continue Cancel
— — 4

.

Ficure 3-6. Ready to Complete

14.  Sclect Edit the virtual machine settings before completion.

15.  Verify the settings for the new virtual machine and then click Continue.
The Virtual Machine Properties screen appears.

16. Open the Hardware tab and select Memory (adding).
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Memory Configuration appears in the right pane.

pu —
@ SafeSync for Enterprise - Virtual Machine Properties

—‘ =)

Hardware | Ophonsl R.esouoesl

" show All Devices Add... | Remove |
Hardware Summary

[l cPus (adding) 2

@ Video card (adding) Video card

= VMCI device (adding) Restricted

€5 New CD/DVD (adding) Client Device

& New Floppy (adding) Client Device

e New SCSI Controller (add...  LSI Logic Parallel
EB New NIC (adding) VM Network

Ef New NIC (adding) Private Network
& New Hard Disk (adding) Virtual Disk

—Memory Configuration

1011 GE =] MEI'HO(VS!ZE:I ﬁs - leB =
512 GBH T o e
sescpl] 9 ouestos: 1011GE.
Maximum recommended for best
e A performance: 43148 MB.
64 GEH Default recommended for this
4 guestos: 334 MB.
=GB Minimum recommended for this
16l ¥ guestos: z2mB.
= el)
4GB

2GB

1GE

Ficure 3-7. VM Properties - Memory Configuration

17. In the Memory Size field, select at least 8GB.

18. From the Hardware tab, select CPU (adding).

CPU settings appear in the right pane.
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( - EN
v ==
g SaieSylt_for Enterprise - Virtual Machine Properties
Hardware | Options | Resources |
™ Show Al Devices Add... | Remove | Number of virtual sockets: |1 vl
ﬁaﬂl’m | Summary 1 Mumber of cores per socket: |2 vI
Wl Memory (adding) 8192 MB
Total number of cores: 2
E‘ card (adding) card /&, Changing the number of virtual CPUs after the t
. . . of vir a guesi
&= VMCI device (adding) Restricted 05 is installed might ] "
€5 New CD/DVD (adding) Client Device unistable.
g New Floppy (adding) Client Device
(@ New 5CSI Controller (add...  LSI Logic Parallel The virtual CPU configuration spedified on this page
EB) New NIC (adding) VM Network might violate the license of the guest 0S.
EB New NIC (adding) Private Network
= New Hard Disk (adding) Virtual Disk

Ficure 3-8. VM Properties - CPU Settings
19. In the Number of virtual sockets field, select 1.
20. In the Number of cores per socket field, select 2.

21. Click Finish.
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Installing on a VMware Workstation

When installing SafeSyncon a VMware Workstation, the virtual machine requires the

following:

SYSTEM

Minimum REQUIREMENT

Virtual machine

VMware® WorkStation™ 6.x, 7.x or above

CPU 64-bit single core
RAM 8GB

Hard disk 60GB

Network cards Two 1GB NIC

Procedure

1. Launch a VMware WorkStation.

2.  Select File > New > Virtual Machine from the menu.
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A setup wizard appeats.

Mew Virtual Machine Wizard

Vilware®

Workstation 9

Help |

T - e I 25—

Welcome to the New Virtual
Machine Wizard

What type of configuration do you want?

) Typical {recommended)

Create a Workstation 9.0 virtual machine
in a few easy steps.

Create a virtual machine with advanced
options, such as a SCSI controller type,
wirtual disk type and compatibility with
older VMware products,

= Back [ Mext = ] [ Cancel I

Ficure 4-1. Virtual Machine Configuration

3. Select Custom (advanced).

4. Click Next.
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The Virtual Machine Hardware Compatibility screen appears.

Choose the ¥irtual Machine Hardware Compatibility
Which hardware features are needed For this virkual machine?

—¥irkual machine hardware compatibility
Hardware compatibilicy:

Compatible with: ¥ ESy Server

Compatible products: Lirnitations;
ES 5.0 =] &4 GE memory limit =]
Fusion 4.0 & processar limik
Fusion 5.0 10 nebwork adapter limit
Workstation 3.0 2 TB disk size limit

Workstation 9.0

[=] =]

Help | < Back Il Mext = I Cancel |

Ficure 4-2. Virtual Machine Hardware Compatibility screen

5.  Sclect Workstation 8.0 from the drop down list.

6. Click Next.
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The Guest Operating System Installation screen appears.

I T
=

Guest Operating System Installation
A virtual machine is like a physical computer; it needs an operating
system. How will vou install the guest operating system?

Install from:

) Installer disc:

@Dm R Drive (F:) -

71 Installer disc image file (iso):

| vl [ Browse... ]

The wvirtual machine will be created with a blank hard disk.

[ <mock ][ mextz ][ concel ]

Ficure 4-3. Guest Operating System Installation screen

7.  Select I will install the operating system later..

8. Click Next.
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The Select a Guest Operating System screen appears.

P
L L o

Select a Guest Operating System
Which operating system wil be installed on this virtual machine?

Guest operating system

) Microsoft Windows
) Linux

7 Movell NetWars
) WMware I
@) Other

Other 64-bit

Ficure 4-4. Select a Guest Operating System screen
9.  Specify the following:

+  Guest operating system: Other

«  Version: Other 64-bit

10. Click Next.
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The Name the Virtual Machine screen appears.

Mew Virtual Machine Wizard ‘

Name the Virtual Machine
What name would you like to use for this virtual machine?

virtual machine name:
SafeSyncForEnterprise

Location:
D:\wmware \SafeSyncForEnterprise Browse, ..
The default location can be changed at Edit = Preferences.

[ <Back | [ mext> |[ cancel |

Ficure 4-5. Name the Virtual Machine screen
11.  Type a name for the virtual machine.
12. Type a path for file storage.
13. Click Next.
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The Processor Configuration screen appears.

[—— |
v waT

Processor Configuration
Spedfy the number of processors for this virtual machine.

Processors

Mumber of processors: [1 v]

Mumber of cores per processor: [1 v]
F Total processor cores: 1

Ficure 4-6. Processor Configuration screen

14. Provide the number of processors and the number of cores for the processors that
the virtual machine uses.

15. Click Next.
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The Memory for the Virtual Machine screen appears.

Memory for the ¥irtual Machine
Howe much memary would wou like to use For this virkual machine?

Specify the amount of memary allocaked o this virtual machine, The memory size
musk be a mulkiple of 4 MB,

64 GE - Memory For this wirtual machine: I awd_,::' MEB
322Gk -
16 GB -
igg _{'_I Maimum recommended memory:
sam - & | 2848 MB
1G58 -
E1Z ME - Recormmended memary:
256 ME - <l 256 MB
128 ME -
B4 ME - [ fGuest 05 recommended mininun;
ZME - <] 3z MB
16 ME -
gME -
4MB -

Help | < Back Il Mext = I Cancel

FiGure 4-7. Memory for the Virtual Machine screen

16. Specify at least 8GB RAM for SafeSync.

17. Click Next.
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The Network Type screen appears.

P
MNewviai Ve

Network Type
What type of network do you want to add?

Metwork connection

) Use bridged networking
Give the guest operating system direct access to an external Ethernet

) network. The guest must have its own IF address on the external network. I
:Gnre the guest operating svsban.écé-és'stoﬁﬁhostwba'sﬁal—mor I
external Ethernet network connection using the host's IP address.

) Use host-only networking ]
Connect the guest operating system to a private virtual network on the host N
computer.

) Do not use a network connection

i

. <Back | [ mMewt> | [ cancal |

[ -

Ficure 4-8. Network Type screen

18. Sclect Use network address translation (NAT).

19. C(lick Next.
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The Select I/O Controller Types scteen appears.

J e )

Select I/ 0 Controller Types
Which SCST controller type would you like to use?

1/0 controller types

IDE Controller: ATAPT

SCSI Controller: | BusLogic (Mot available for 64-bit guests)
@ {S[logic (Recommended)

) LSI Logic SAS

[ <Back |[ mect> |[ cancel |

Ficure 4-9. Select I/0 Controller Types screen

20. Select LSI Logic (Recommended).

21. Click Next.
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22.

23.

The Select a Disk Type screen appeats.

r Bl
Mew Virtual Machine Wizard - “

Sselect a Disk !
Which disk do you want to use?

A'urrh..tal :islc;::orrposed of one or more files on the host file system, which
will appear as a single hard disk to the guest operating system. Virtual disks
can easily be copied or moved on the same host or between hosts.

() Use an existing virtual disk
Choose this option to reuse a previously configured disk.

) Use a physical disk (for advanced users)
Choosze this option to give the virtual machine direct access to a local hard
disk.

s ) (o) [ conea )

Ficure 4-10. Select a Disk screen

L

Select Create a new virtual disk.

Click Next.
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The Select a Disk Type screen appeats.

MNew Virtual Machine Wizard ‘

Select a Disk Type
What kind of disk do you want to create?

virtual disk type
@ 5Cs1

[ <Back | [ Mext> ][ Cancel

Ficure 4-11. Select a Disk Type screen

24. Sclect the (Recommended) disk type.

25. Click Next.
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The Specify Disk Capacity screen appears.

Specity Disk Capaciby
How large do you want this disk to be?

e T

Maximum disk size (GB): 60

R.ecommended size for Other 54-bit: 8 GB

[T Allocate all disk space now.
Allocating the full capacity can enhance performance but requires all of the

physical disk space to be available right now. If you do not allocate all the
space now, the virtual disk starts small and grows as you add data to it.

() Store virtual disk as a single file
@ split virtual disk into multiple files

Splitting the disk makes it easier to move the virtual machine to another
computer but may reduce performance with very large disks.

[ <Back ][ mewt> ][ cancel

Ficure 4-12. Specify Disk Capacity screen
26. Specify at least 60GB of disk space for SafeSync.

27. C(lick Next.
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The Specify Disk File screen appears.

Mew Virtual Machine Wizard ‘

sSpecify Disk File
Where would vou like to store the disk file?

Digk File
One disk file will be created for each 2 GB of virtual disk capadity. File names for

each file beyond the first will be automatically generated using the file name
provided here as a basis.

yncForEnterprise. wmdk | Browse. ..

[ <Back | [ mext> ][ cancel |

Ficure 4-13. Specify Disk File screen
28. Specify where to store the disk file.
29. Click Next.
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The Ready to Create Virtual Machine screen appears.

Ready to Create ¥irtual Machine

Click Finish ko create the virkual machine, Then vou can inskall Other
64-hik,

The wirtual machine will be created with the following settings:

Marne: SafeSyncForEnterprise =
Location: DvWhADE Safe ByncForEnterprise
Wersion: Workstation 8.0

Operating Syst..  Other 64-hit

Hard Disk: 6l GB, Split

bermory: 2196 ME -
< | | E

Cuskomize Hardware. .,

< Back I Firish I Cancel

Ficure 4-14. Ready to Create Virtual Machine screen

30. Click Customize Hardware.
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The Hardware screen appears.

Hardware |Optl0ns I

Device | UTTED | ~Device status

I Mernory 8 GE ™ Connected

[ Pracessors 1 v Connect ak power an

A Hard Disk {IDE) 60 GB

) CDjovVD (IDE) Auto detect  Connaction

[ Floppy fto detect  Use physical drive:

@Network Adapter MAT

@) Sound Card fto detect I.C\uto detect d

Display Auto detect * Lse IS0 image file:
ID:'l,BuiId'lBuild'l,SaFeSyncForEntenLI Browse, ., I

Advanced... |

Add... Remove

QK Cancel Help

Ficure 4-15. Hardware screen
31. Select New CD/DVD.
The Select New CD/DVD screen appeats.
32. Select Use ISO image file and select the SafeSync ISO file.

33. Click Add.




Installing on a VMware Workstation

The Hardware Type screen appears.

Hardware |Optl0ns I

Device | Surnrar | Device status
I Mernory 8 GE ’7 ™ Connected
[ Processors 1 I marmact b =k mrisiar Ao
=\ Hard Disk (IDE} £ x
@CDIDVD (08 5 Hardware Type
E Floppy f ‘What kype of hardware do you want to install?
ENetwork Adapter I
@) Sound Card £ - I
B pisplary ¢ Hardware —Explanation
A Hard Disk Add a network adapter,
() CD{OVD Drive QDLI
E Floppy Drive
apker Advanced... |
@) 50und Card
Parallel Part:
E Serial Port

Frinter
Generic SCSI Device

< Back. | Next = I Cancel

add... Remove |

QK I Cancel Help

Ficure 4-16. Hardware Type screen

34. Sclect Network Adapter.

35. Click Next.
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36.
37.

38.

The Network Adapter Type screen appears.

-
Add Hardware Wizard

W e -

Metwork Adapter Type
[l What type of network adapter do you want to add?

Metwork connection

[ | replicate physical netweork connection state
@) MAT: Used to share the host's IP address
) Host-only: A private network shared with the host

() Custom: Specific virtual network

I ['l.-"MnetU {Auto-bridging) -

Device status
Connect at power on

[ <Back || Finish

J [ cancel |

. — =

Ficure 4-17. Network Adapter Type screen
Select NAT.
Select Connect at power on.

Click Finish.




Installing on a VMware Workstation

The Hardware screen appears.

Hardware |Optl0ns I

| ~Device status

Drevice | Surnmar’

I Mernory 8 GE ™ Connected

[ Pracessors 1 I~ Conneck ab power on

A Hard Disk {IDE) 60 GB

@CD,I’DVD (IDE) Using File D:\Build\SSFEYSafesync.. . - Metwork connection

[ Floppy fto detect " Bridged: Connected directly to the physical netwark

@Network Adapter MAT

™ Replicate physical network connection state

OD Sound Card futo detect % MAT: Used to share the hast's IP address
D'SDlaV fiuto detect ' Host-only: A private network shared with the hask
' Custorn: Specific virtual network,

Jsvaneta e

 LAM seqment:
| ]

LAN Segments... | Advanced, .. |

add... Remove

QK I Cancel Help

Ficure 4-18. Hardware screen

39. Click Close.
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The Ready to Create Virtual Machine screen appears.

Ready to Create ¥irtual Machine

Click Finish ko create the virkual machine, Then vou can inskall Other
64-hik,

The wirtual machine will be created with the following settings:

Marne: SafeSyncForEnterprise =
Location: DvWhADE Safe ByncForEnterprise
Wersion: Workstation 8.0

Operating Syst..  Other 64-hit

Hard Disk: 6l GB, Split

bermory: 2196 ME -
< | | E

Cuskomize Hardware. .,

< Back I Firish I Cancel

Ficure 4-19. Ready to Create Virtual Machine.

40. Click Finish.




Installing on an Oracle VM VirtualBox

When installing SafeSyncon an Oracle VM VirtualBox, the virtual machine requires the

following:

SYSTEM

MiNIMuM REQUIREMENT

Virtual machine

Oracle VM VirtualBox™ 4.2.x

CPU 64-bit single core
RAM 8GB

Hard disk 60GB

Network cards Two 1GB NIC

Procedure

1. Log on to the Oracle VM VirtualBox.

2.  Click the New button on the toolbar to add a new virtual machine.

3. Click Next.

The Name and operating system screen appears.
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( ~
%9 Oracle VM VirtualBox Manager (o B8] =

File Machine Help

@8 D>P

(CiDetls) () snapehes
New Befings  Start  Diseard

Name and operating system

Please choose a descriptive name for the new virtoal machine and select the type
of operating gystern you intend to insall on it. The name you chooss will be used
thronghout VirtwalBow to identity this machine.

Name: SSFE

Type: [Linux

:
Version: |Ubuntu (54 bit) ] rn}‘:

Hide Des:n'pnon] I Next

4.  Provide a name for the virtual machine.

5. Sclect the following for the operating system type and version:
+ Linux
+  Ubuntu (64-bit)

6. Click Next.

The Memory size screen appears.
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7.

8.

%9 Oracle VM VirtualBox Manager

File  Machine  Help

@ 92 P

New Rettings St Disa

meate Virtual Machine

Memory size

machine

Select the amount of mewmaory (RAM) in megabutes to be allocated to the wirtnal

i The recommended memory size iz 512 MB.

4 MB

.U 8192 ME

6152 MB

Specify the amount of memory allocated to the virtual machine.

Tip

Trend Micro recommends specifying at least 8GB of memory.

Click Next.

The Hard drive screen appears.
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-
¥ Oracle VM Virualg L
File Machine Help

@ <D P

New Zeittings Start  Diseard

Hard drive

If you wish you can add a virtual hard drive fo the new machine. You can either
create anew hard drive file or select one from the list or from another location

using the folder doon.

If you need a more complex storage set-up you can skip this step and make the
changes to the maching settings once the machine is created.

The recommended size of the hard drive i:8.00 GB.
) Do notadd a virtoal haxd drive

@ Create a wirtnal hard drive now

() Vse an existing virtual hard, drive file

[Empty

9. Select Create new hard drive now.

10. Click Create.
The Hard drive file type screen appears.
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11.

12.

( 5
%9 Oracle VM VirtualBox Manager =B =

File Machine Help \

@ @

New Bettings  Start

| Bse you hawen't created.

’

Hard drive file type

Please choose the type of file that you would like to use for the new virtnal hard drive. If you do
not need to nse it with other virnalization software vou can leave this sething wnchanged.

@ VDI (VirtoalBox Disk Tmage)
(@) VMDK (Virbual Machine Diisk)
(©) VHD (Virtusl Hard Disk)

(©) HDD (Parallels Hard Disk)

() QED (QEMU enhanced disk)

) QCOW (QEMU Copy-On-Writs)

Hide Dascriptinn] [ Next ] [ Cancel

Specify the type of the virtual disk to use.

Tip
If you do not use the virtual machine with other virtualization software, leave the
setting as VDI (VirtualBox Disk Image).

Click Next.

The Storage on physcial hard drive screen appears.
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[=]m = )

-
8§ Oracle VM VirtualBox Manager
File Machine Help

{; @ I::) - (&) Enapshots

New Settings Stat §

. . i vou haven't created
Storage on physical hard drive

i
Please choose whether the new virtual haxd doive file shovld grow az it is used ({dymamically
allocated) or i it showld be crested at its masdimom size (fueed size) ’ b o

4 dynamically allocated hard drive file vill only vee space on your physical hard drive as 1t
fille up {up o & maxdmum fixed size), although it will not shrink sgain sutomatically when
space on it 1z freed..

& fiwed size hard drive file may take longer to create on some systems but iz often faster to vee

@ Dymamically allocated
() Fixed size

13.  Specify whether disk space if allocated dynamically or if disk space is fixed.

Note

Dynamically allocated space is allocated as the space fills up.

Fixed disk space only takes as much space as you allocate, but the fixed size disk is

often faster to use.

14. Click Next.

The File location and size screen appears.
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i ~
ﬂmcle VM VirtualBox Manager — = | = 2|

File: Machine  H

B <
w \> G Create Virtual Hard Drive
New Beftings  Start B

| B Snepshots

File location and size
se you haven't created.
Please type the name of the new wirtval hand dove file into the box below or click on the foldex
ieon o select a different folder to create the file in.

SSFE

Belect the size of the wirtwal hard drive o megabytes. This size 1v the limit on the amount of file
data that a virtoal machine will be sble to store on the hend drive.

I
P m CmB B uw bn BEG NG 6o O —o0eeh

200TE

15. Specify a name and location for the virtual disk.

16. Specify the size of the virtual disk.

Tip
Trend Micro recommends specifying more than 60GB.

17. Click Create.

The virtual machine appears in the virtual machine list.
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W§ Oracle VM VirtualBox Mm EI@B

File Machine Help

([ ebls] @) oapshers

Q General N \(@ Preview N |
Name:

\Operatmg Systern:  Ubuntu (64 bif) )
:/ System B

Base Memory: 8192 MB SSFE
Boot Order: Floppy, CIVDYD-ROM, Hard Disk
\Acceleraﬁnn VT-2/AMD-¥, Nested Paging |

r Display )

Video Memary: 12MB
\Remme Desktop Server: Disabled )|

:f@ Storage p

II Controller; IDE |
IDE Secondary Magter: [CDVDVD] Empty

Controller: SATA
| BATA Pestl: SSFE.vdi (Momal, 60.00 GB) )

r{ia Audio B

Host Driver:  Windows DirectSomnd
\Cnntmllsr ICH AC97 )

f'_ﬂ Wetwork
Manage the virtual machine settings

18. Sclect the new virtual appliance.

19. Click Settings from the main menu to set up the environment for SafeSync.

The Settings screen for the virtual machine appears.
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%9 Oracle VM VirtualBox Manager =B % ]

B General ‘ Storage
System
- Storage Tree Atibutes
Displ
Py @ Contraller IDE CI/DVD Drive: [IDE Seconday Master =
@ Storage : 1 =
@) Emty Live CDDYD @ Choose a virtual CD/DVD diskfile...
5 Audio A Contoloc SAT Informstion | Host Drive 'D-*
Network T, - e B
& O FE_wdi e Host Drive 'F-
B serial Ports Size: -
5 uss P @ Remove disk from virtual drive
- Attached To: - b
Shared Folders
a@ae
Selecta stines caisgors from the dit o éhe Ief-band sife and move the mouss over a seitines iem 0
et more infoumation,

20. Click Storage from the Settings screen.
The content for Storage appears.
21. Sclect IDE Controller.

22. Right-click the CD/DVD drop down list and select
SafeSyncForEnterprise-2.1.iso.

23. Click Network from the Settings screen.

The content for Network appears.

Note

SafeSync uses Adapter 1 network settings.

The SafeSync database uses Adapter 2 network settings.
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-
W9 Oracle VM VirtualBox Manager

Q General

| Network

System -
Disol ALdapter 1 | Adapter 2 | Adapter 3 | Adapter 4 ‘
=l Display
nal etworl apter
@ Storage [#/] Enable Network Ad
B Audio Attached to:
Not attached

BP Network Wame: gﬁdT i -]

il apter
{9 Serial Ports (> Advanced | [nternal Network
& UsB Cheneric Driver J

Shared Folders Host-only Adapter i

Sefect a settings category ffom e S5t o e feffand site and move e mouse over a seitings fem 0
Fef Mo fTfDrmation,

[ ok ][ Gamem |[ Hp |

24. Specify one of the following for Adapter 1:

+  Bridge Adapter: Select this option to allow connection to SafeSync using
public networks.

+  Host-only adapter: Select this option to only allow local access to SafeSync.

25. Click Adapter 2.

The Adapter 2 tab displays.
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r —— = N
%8 Oracle VM VirtualBox Manager NN

File:

[

General | Network

System
Adapter] | AdapterZ | Adepter3 | Adapters

Display

@ Storage Encble Network Adepter

B Audo et

P Network Nome:  intoet -

ﬁ Serial Ports [ Advenced

& uUse )
Shared Folders

Select 2 settings cafepory fom the 5t o e feftband side and move e mouse over a seltings fem o
Il et moie ffOrmation,

[ ok || Comal |[ Hep |

26. Specify Internal Network for Adapter 2.

27. Click OK.







Installing on Microsoft Hyper-V

Installing SafeSync on Microsoft Hyper-V requites the following:

SYSTEM

MiNIMuM REQUIREMENT

Virtual machine

Microsoft Hyper-V™ 6.2.9200.16384

CPU 64-bit single core
RAM 8GB

Hard disk 60GB

Network cards Two 1GB NIC

Procedure

1.  Launch Hyper-V Manager.

2.  Select the host server.

3. Click Action > New > Virtual Machine from the main menu.

The New Virtual Machine Wizard screen appears.
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«=| z[E]

23 Hyper-V Manager - -
/& WIN-GER20UAUHOH i ﬁ
New »
N [ Import Virtual Machin...
Before You Begin ) Hypery Settings.
1 Virtual Switch Manage...

) Virtual SAN Manager...
¢ Edit Disk...

i te rou can use i physical
‘computers for 2 variety of uses. You can use this wizard to canfigure the virtusl machine now, and

To create a virtual machine, do ane of the following: (L Inspect Disk...

i with default values. (@ Stop Senvice
A i anfaln. % Remave Server

3 Refresh

e View »
Help
[ssre
= Connect...

Settings...

© Start

[ Do not show this page again E Move..

<o | [ o] [

TSSFE

Enable Replication...

Help

Adapter: Legacy Network Adapter (Dynamic MAC: 00:15:50:C0:7D:03)
Connection:  ntel(R) 82574L Gigabit Network Connection - Vitual Switch
1P Addresses:

Status:

Summary | Memory | Networking | Replication

4. Click Next.

The Specify Name and Location screen appears.
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e Acion View Help
L]
38 Hyper-V Manager Actions.
[ WIN-GERZOUAUHOH

L Impor Virtusl Machin...
[ Hyper:V Sestings...
2 Virtual Switch Mansge...
bl Virtusl SAN Manager...
o EdDisk..
o Inspect Disk..
@ Stop Senvice.
: ¥ Remove Server
— ] Slore the wbialmachie n 3 et locaton 5 G Refresh

Locaton: [C:ProgramDotapcrosoftiindons Fper ¥\ [ o View |

17 vou sl 10 take smaoshas of thi veal machine, elect a lacatan tat s enough fee H Hep

e "

i Connect...
T settings..
© s
a Snapshot
P Move.
=) Eport..
o] ok g
Delete..
TSSFE B0 Enable Replication..
B v

Adapter:  Lugacy Netwark Adapter Dymsmic MAC: 00-155D.C0 D03
Commection:  IntsiR) £2574L Gigabt Netwodk Comnection - Vitua Swtch
1P Addresses:

status:

e e

G O

5. Type a meaningful name for the virtual machine.

Example: SafeSync for Enterprise
6. Click Next.

The Assign Memory screen appears.
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Fle Adion View Help
« | onfm]
32 Hyper-V Manager Actions:
5 WiN-GERZDUAUHOH
New »
L Impont Virtual Machin...
¥ M
ﬁ Assign Memory £ Hyper Setings..
2 Virtual Switch Mansge...
Before YouBegn Spedfy the amount of ¥ anl, Virtusl SAN Manager...
Spesfy None sndLocaton g o EdDisk..
Corors Nabrarbing i s & Inspect Disk...
S T e Dymame Memory for s urtusl machine. @ Stop Semice
) . ¥ Remove Server
G Refresh
Sumary
0 View »
Help
i Connect...
i Settings...
@ sen
Ba Snapshot
P Move.
=) Eport.
Ce=1] o) e
e Delete..
ks 0 Enoble Replcation...
Adapter:  Legacy Network Adspter Dymamic MAC: 00155D.C0TD.03) [/ | [B Hee
Connection:  nsi) E2574L Gigab Network Connectin - Witual Swtch H
P Addresses: -
Status: |
“Sumary | Memory | Networking | Fevlcatin

7.  Specify at least 8GB of startup memory.

Tip

Trend Micro recommends allocating 32GB of startup memory for best performance.

8. Specify whether disk space if allocated dynamically or if disk space is fixed.

Note

Dynamically allocated space is allocated as the space fills up.

Fixed disk space only takes as much space as you allocate, but the fixed size disk is
often faster to use.

9. Click Next.

The Configure Networking screen appears.




Installing on Microsoft Hyper-V

File Action View Help

«=| 2

3 Hyper-V Manager Actions
/& WIN-GER20UAUHOH i
»

Mew

- & [ Import Virtual Machin...
Co Networki
niigure g 1] Hyper-V Settings...

1 Virtual Switch Manage...
You can configure tousea ) Virtual SAN Manager...

¢ Edit Disk...
Connection: | Intel(R) 82574 Gigabit Network Connection - Virtual Switch v rg—_—
Inspect Disk..

Esch i
virtual switeh, o it ezn remain disconnected.

(@ Stop Senvice

75 Remove Server

3 Refresh

e View »
Help

[ssre s
= Connect...

Settings...

© Start

s Snapshot

B Move...

&) Export..
<prevous | [ mext> | [ Ensn | [ coneel =] Rename...

Sk Delete..

% Ensble Replication...

Help

TSSFE

Adapter: Legacy Network Adapter (Dynamic MAC: 00:15:50:C0:7D:03)
Connection:  ntel(R) 82574L Gigabit Network Connection - Vitual Switch
1P Addresses:

Status:

Summary | Memory | Networking | Replication

10. Specify the network card needed to connect to the network.

11. Click Next.

The Connect Virtual Hard Disk screen appears.
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e Acion View Help
« | o[ B[
52 Hyper-y Manager Actions:
8 VAN-GER2DUAUOH
New »
4 ImpertVirtusl Machin._.
" Connect Virtual Hard Disk. Li K -
[ Hyper:V Sestings...
2 Virtual Switch Mansge...
Before ou Beon hat v aal. Virtusl SAN Manager...
Speafy Nome sndtocaten = it b EaDsL.
Action Mary @n_m-mmﬁ & o
Canfigre Hetworing @ Sopsenies
(T e e ] it
nstalaton Gptons Locatan; [C-yerapubicDoasment Vrper Vv | O Fia
| I @ View »
©) e an evitig s hard disk H rer
oo
oot [C U Do e VW bt || ome.. | S Sres
o Settings...
© ttach a vihial hard ek nter O s
= Ba Snapshot
P Move.
=) Eport..
i
B Delete..
TSSFE B Ensble Replication..
Adapter:  Legacy Network Adspter Dymamic MAC: 00155D.C0TD.03) [/ | [B Hee
Connection:  nsi) E2574L Gigab Network Connectin - Witual Swtch L
1P Addresses:
status: |
“Sumay [ Memory | Netwokong |Feshoation

12. Specify at least 60GB for the size of the virtual hard disk.
13. Click Next.

The Installation Options screen appears.
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» L=lol x|
Fle Adion View Help
« | onfm]
53 Hyper-V Manager Actions
[ WIN-GERZOUAUHOH
New »
[ Import Vinusl Machin...
" Installation Options
ﬁ [ HyperV Sestings...
T2 Vitual Switch Manage..
Begn Toue aal. Virtusl SAN Manager...
Speify Name sndLocaton 5 : o Bl
ol tigris? Lo & Inspect Disk..
el
Seni
Camect i Hard Ok medis @ oy,
O Physcal COIDND dives [0~ ¥ Remove Sever
Sy nage e (0): |CllSafeSyncrorEnterprse 2.1-1125.50 e O Hen
View »
© Instal an apersting system fam s ot fgpry dek: Help
sdia
O — e
o o Settings..
© s
a Snapshot
P Move.
=) Eport.
=1 o4 dopne.
B Do,
S 1 Encble Replication..
Adapter:  Legacy Network Adspter Dymamic MAC: 00155D.C0TD.03) [/ | [B Hee
1P Addresses: L
status: |
“Surary | Wamery | tetwoking | Fapheaion

14. Select Install an operating system from a CD/DVD-ROM.
15. Sclect Image file (.iso).

16. Specify the location of the SafeSync image file.

17. Click Next.

The Completing the New Virtual Machine Wizard screen appears.




SafeSync for Enterprise Installation Guide

E —|m| x
File Action View Help
L
3 Hyper-V Manager Actions
/& WIN-GER20UAUHOH i
New »
N . (& Import Virtual Machin...
‘Completing the New Virtual Machine Wizard B byper s
pper-V Settings..
1 Virtual Switch Manage...
Before You Begin ha ) Virtual SAN Manager...
followng virtual machine.
‘Specify Name and Location - ¢ Edit Disk...
Eiaibeny . L Inspect Disk...
Configure Networking Name: SafeSync for Enterprise
e M (@ Stop Senvice
Network: Intel(R) 82574 Gigabit Network Connection - Virtual Switch 75 Remove Server
st e Hard Disk: c Hard D Enterprise.y Q Refresh
Wilbe installed prise-2.1-1129 50
e View »
Help
q , [ssre s
= Connect...
To reate the vitual machine and dose the wizard, cick Finish. o
© Start
s Snapshot
B Move...
&) Export..
<pevous | | wets | [ Enen | [ canel =] Rename...
Sk Delete..
SSFE 8 Ensbie Repication..
Help
Adapter: Legacy Network Adapter (Dynamic MAC: 00:-155D:C0-7D:03)
Connection:  Intel(R) 82574L Gigabt Network Connection - Vitual Swich
1P Addresses:
Status:
Summary | Memory | Networking | Replication

18. Verify that the settings are correct.
19. Click Finish.
The SafeSync virtual machine appears in the VM List.

20. Select the SafeSync virtual machine.

21. Seclect Action > Virtual Switch Manager.
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The Virtual Switch Manager screen appears.

|

»

»

53 Hyper-V Manager In i i
5 WIN-GER20UAUHOH Virtual Machines [~ 24 new vrtusl netnork nitch
ey - ® 4 Intel(R) 82574 —
2 Ssfeymofor Etepn Intel(R) 82574 Gigabit Network C. [Few vituat Switch ] New
e e Import Vitual Machine...
Hyper-V Settings...
T MAC Address Range ] || it switeh Manager..
00-15-5D-C0-7D-00 to 00-15-5D-C.
Comecton type Edit Dick...
What do you want to connect ths vitual sich to?
Inspect Disk...
O external network:
; Stop Service
[ v
Snapshots
& share ti tead
: Refresh
] Enable snge-ro0t 1/0 vrtualzation (SR-10Y) 7
O Internalnetwork
Help
— [eSmeforEmerprise 4.
Connect...
(] Enable virtual AN identification for management operating system
Settings...
“The v spes virtual LAN
ystem vl use for il network commuricatons hrough this network adapter. This Stert
setting does not afect virtual machine netvorking.
Snapshot
— Move...
SafeSync for
Rename...
crel
An external
Hot| 0= = Delete...
St Enable Replication...
Help
o]
Summary [ emory

22. Create a new network.

23. Provide a meaningful name for the internal network.

24. Select Private network.
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Note

For the external network verify that Allow management operating system to
share the network adapter is selected.

ik £
53 WIN-GER20UAUHOH
Name:
[l 2574 Ggabit etworkConmecton Vet Swich N S v
5 wnr2 e o Import Virtual Machine..
Private vitusl i
A_Global tetwork settings ~ Hyper:¥seiinge:..
MAC Address Range Virtual Switch Manager...
00-15-5D-C07D-00 t0 00-15-5D-C.. 5 i
Comnecton type EditDisk..
What do you want to connect tis virtual swich to? "
& Inspect Disk..

Stop Senvice

m V]
Snapshots 2 s

View 5
O mtemanetmak
© prvate network L
o
] Enable virtual LAN identificaion o management aperating system Connecty
e
Thewar e
e St
S e Wi e i
o g T
Move..
SafeSync for Ent|
Bt
Rename...
e
el
ot o o Delcte..
switch, Enable Replication...
Hep
[
Sy | oy
T

25. Click Apply.
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The VM List appears.

File Action View Help
o s BE
33 Hyper-V Manager

8 WIN-GERZOUAUHOH Virtual s ‘ﬁ
Name. ol State CPUUsage  Assigned Memory  Uptime. Status

»

i New
EP 1B, rpo Vil Michin.
4 Hyper-V Settings...
T Vietual Switch Manage...
e Wil Virtus! SAN Manager.
e p— o EditDik...
5 Inspect Disc.
Rename... @ siop Senice
o K Remove Server
i i G Refrech
Snapshots s B S| v ’
The seected whual maching has o snapsbols B ep
o Connect..
o Settings..
© St
B Snapshot
B Move.
=) EBport..
=] Rerame..
B Delete..
®
Adopters  Netwodk Adapter (Dynaic MAC: Not sssigned) B e
Connection: i) E2574L Gigabit Netwodk Conncton - Vitua Swech
1P Addresses:
status:
“Sunmary | Mamory | Netwoking |Replestion

26. Right-click the SafeSync virtual machine.

27. Select Settings.
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The Settings screen appeats.

File Acion View Help
«+ sl 8
32 Hyper-y Manager |
i M
= | Sefesy e ~4rG
Jne reew »
§ Socsyg| |2 Mardware T Add Hardnare 2 "
Fre ] Acd s mport Virtusl Machin...
5 s You can use th seting to ck devices 0 your vrual machne, &
Baot from €O ‘Select the devices you want to add and dick the Add button,
= temcry S5 Comroller
ansems sl SAN Manager..
[ Processee
= 1 ¥irtial processor (Edit Disk...
& I8 1DE Conwaler 0 RemotefX 3D Video Adapter Inspect Disk...
e Hard Drive
e o B [ha ] [fororsevice
= 0 1€ Contoler 1 Remove serier
£ 0V Drive se 3l quest B
SafeSyncharEnterprise-2.1-11.. el ey,
Snapshol | sostconvoter e few »
F com1
Mare e
Tz psyncfor Enerprise &
pa. Connect.
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28. Remove all existing network adaptets.
29. Click Add Hardware and select Legacy Network Adapter.
30. Click Add.

A network adapter appears in the Settings list.

31. Add a second network adpater, by clicking Add Hardware and selecting Legacy
Network Adapter.

32. Click Add.
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A second network adapter appears in the Settings list.
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33. Click OK.

Installation is complete.







Chapter 7

SafeSync Post-Installation Tasks

This section outlines recommended and optional post installation tasks for SafeSync.

This chapter has the following topics:

Mounting Additional Disks on page 7-2
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Mounting Additional Disks

SafeSync automatically mounts only one disk by default. Additional disks need to be
manually mounted to SafeSync.

The example below assumes that SafeSync is deployed as a set of paired appliances, and
the primary server already has one disk installed. This example describes how to add a
new disk to the primary server.

Note

You have to do these steps only if you want to use more than one disk.

Procedure

1. Log on to SafeSync.

2. Obtain the root permission:
sudo -1i

3. Specify the root password.

4.  Format the disk before mounting it to SafeSync:
This example uses sdb as the name of the new disk.
dmesg | grep sdb
fdisk /dev/sdb

5.  Mount the disk:
mkfs.ext3 /dev/sdbl
mkdir /storage/mogdata/devl12
mount /dev/sdbl -t ext3 /storage/mogdata/devl2

6. Add the disk to the mogile system:

chown www-data:mogstored /storage/mogdata/devl2
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chmod g+w /storage/mogdata/devl12

mogadm —--trackers=trackerl:6001 device add osdp-storel 12
--status=alive

Save the settings:
vi /etc/fstab

/dev/sdbl /storage/mogdata/devl2 ext3
defaults,user xattr, netdev 1 2







Verifying Installation

After installing SafeSync, Trend Micro recommends testing the installation.

Procedure

1.

Open the SafeSync web console using the following address: https://
www.example.com/

Note

The actual address may vary according to your DNS settings.

Log on into the SafeSync web console using the default account credentials:
+  User name: administrator

. Password: safesync

Click Upload Files to upload files to SafeSync.

The Upload Files screen appears.

Select the files you want to upload and click Add Files.

Select at least one photo to upload.

Click Start Upload.
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The files you select upload to SafeSync.

) IREND. | SafeSync for enterprise

‘administrator (adminsirator) - Sign out

] 0 (e 9] i

[P Account information

@] View this photo 2 5150d83aru1_s1500_sa280._was uploaded f tisfolder

£ Defauit TeamFolder Org

(51 Download this photo 18 Tip: Install SafeSync to have changes to the . Download Now 14D Using 24.33 GB of 1501 GB
View details
< Getlinktothis photo . Pe—
iame ypo Last Modied 8 Seats usna: 280050
Previous versions EroeE
o () 2 Backup File Foider 210812012 15:38. §? Customization
[ Editon your computer = ‘Support Details.
X Delete this photo

7 Rename this photo
3 Move or copy this photo

P [ 16258
[/ Backup. [ sep2012

@ (g Team Folders

1@ Recycl Bin

5150dB3arvl_s1500_aa280_
JPEGIFIF Image

Note

The photos you upload to SafeSync, display as a thumbnail in the content area.
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Select the files that were just uploaded and click Download the selected items.

A dialog box appears.

Specify where to download the selected files and click OK.

The selected files download to the location you specify.

Select a photo you uploaded and click View this photo.

The photo appears in its original size.
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® - O SafeSync- thumbnail.aspx - Mozilla Firefox

{} appliance.com appliance.com

Share your files by selecting a file and clicking Get link to this file.

SafeSync creates a shareable link to that file. People you send that link are able to
access the files by clicking the link.
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Share this photo

SafeSync provides security for any link you share. For additional
protection, use any or all of the options below. Move your mouse
cursor over an option to learn more about it.

Shareable link | https:/ fwww.example.com/KgC/09-10

B@E0rn=a

Enable Extra Protection

menrd| |

Link expires on | |

Single-use link [




Chapter 9

Contacting Technical Support

Trend Micro provides technical support, pattern downloads, and program updates for
one year to all registered users, after which you must purchase renewal maintenance. If
you need help or just have a question, please feel free to contact us. We also welcome
your comments.

«  Getallist of the worldwide support offices at b#zp:/ [ esupport.trendmicro.com
. Get the latest Trend Micro product documentation at h##p:/ / does.trendpaicro.com

In the United States, you can reach the Trend Micro representatives through phone, fax,
or email:

Trend Micro, Inc.

10101 North De Anza Blvd.,

Cupertino, CA 95014

Toll free: +1 (800) 228-5651 (sales)
Voice: +1 (408) 257-1500 (main)

Fax: +1 (408) 257-2003

Web address: http://www.trendmicro.com
Email: support@trendmicro.com



http://esupport.trendmicro.com
http://docs.trendmicro.com
http://www.trendmicro.com
mailto:support@trendmicro.com
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